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1 Important notes on Dymola 

Installation on Windows 

To translate models on Windows, you must also install a supported compiler. The compiler 
is not distributed with Dymola. Note that administrator privileges are required for 
installation. Two types of compilers are supported on Windows in Dymola 2016: 

Microsoft Visual Studio C++ 

This is the recommended compiler for professional users. Note that free Microsoft compiler 
versions earlier than Microsoft Visual Studio Express 2008 are not supported (concerning 
full versions, some earlier versions are supported). Refer to section “Compilers” on page 68 
for more information. 

GCC 

Dymola 2016 has limited support for the MinGW GCC compiler, 32-bit and 64-bit. For 
more information about GCC, see section “Extended GCC compiler support” on page 48. 

Installation on Linux 

To translate models, Linux relies on a GCC compiler, which is usually part of the Linux 
distribution. Refer to section “Supported Linux versions and compilers” on page 69 for 
more information. 

2 About this booklet 

This booklet covers Dymola 2016. The disposition is similar to the one in Dymola User 
Manual Volume 1 and 2; the same main headings are being used (except for, e.g., Libraries 
and Documentation).   
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3 Dymola 2016 

3.1 Introduction 

3.1.1 Additions and improvements in Dymola 
A number of improvements and additions have been implemented in Dymola 2016. In 
particular, Dymola 2016 provides: 
• Filtering in the diagram layer (page 8). 
• Navigation improvements 

o Tabs in main window (page 9). 
o Instance hierarchy (page 15). 

• Searching connections and connected components (page 16). 
• Drag & drop of classes in the package browser (page 17). 
• Improvements in the Documentation layer: 

o Improved navigation between editors (page 19). 
o Improved documentation editor, including table creation and edition 

(page 20). 
• Improved coverage for Flat Modelica (page 23). 
• Support for including resources in Save Total (page 23). 
• Displaying variable dependencies by plotting (page 28). 
• Plot handling improvements: 

o Drag & drop of curves between plots/diagrams (page 35). 
o Multiple y-axes in plots (page 36). 

• GCC compiler support enhanced: 
o 64-bit GCC supported 
o FMU export support for GCC compilers 

• Improved language handling, in particular for Japanese (page 50). 
• Licensing of third party libraries on Windows (page 51). 
• Extended FMI support (page 53): 

o Multiple instantiation of FMUs supported (page 52). 
o Enhanced FMU Export from Simulink (page 53):  

 Support for FMI versions 1.0 and 2.0. 
 Support for Co-Simulation with Simulink fixed-step solvers. 

• Multi-threaded code and model export (page 55). 
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3.1.2 New and updated libraries 

New libraries 

The following libraries are new: 
• Human Comfort Library, version 1.4.1. 

For more information about the new library, please see the section “New libraries” starting 
on page 57. 

Updated libraries 

The following libraries have been updated: 
• Air Conditioning Library, version 1.10. 
• Design Library, version 1.0.4. 
• Electric Power Library, version 2.2.1. 
• Engine Dynamics Library, version 1.2.3. 
• Flexible Bodies Library, version 2.1.1. 
• Fuel Cell Library, version 1.3.1. 
• Heat Exchanger Library, version 1.3. 
• Hydraulics Library, version 4.2. 
• Hydro Power Library, version 2.4.2. 
• Liquid Cooling Library, version 1.4. 
• Model Management Library, version 1.1.4. 
• Plot3D Library, version 1.0.4. 
• Pneumatics Library, version 1.7. 
• Thermal Power Library, version 1.10. 
• Vapor Cycle Library, version 1.2.1. 
• Vehicle Dynamics Library, version 2.1. 

For more information about the updated libraries, please see the section “Updated libraries” 
starting on page 60. 
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3.2 Developing a model 

3.2.1 Filtering in the diagram layer 
The diagram layer can now be filtered to dim components from selected packages. The 
menu is reached by right-clicking, with nothing selected, in an empty space in the diagram 
layer, and selecting View Filter…. The command can also be activated by Edit > View 
Filter…. 

 

The dialog gives possibilities to select all, or to deselect all packages, and to control the 
opacity from fully visible to invisible. 

The feature is important when for example trying to track what components have been 
inserted that are not from e. g. Modelica Standard Library. 

Note that the filtering is connector based: 
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• If any of the connectors of a component is extended from a base class that is part of a 
deselected package, that connector is seen as “filtered”. 

• If all connectors of a component are seen as “filtered”, the component is dimmed. 

The above means that if a component has at least one connector that extends from a base 
class not being deselected, the component is not dimmed. 

3.2.2 Navigation improvements 

Tabs in main window 

More than one model can be open in the main window in Dymola 2016.  

 

The tabs can be rearranged by dragging them. 

Opening of tabs 

When Dymola is opened, one tab is opened as well. 

When creating a new class (except packages) using the command File > New (or 
corresponding button), the new class is opened in a new tab.  

A number of context menus have been enhanced with a new context command Open Class 
in New Tab. Some examples: 
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• Context menu for class in package browser and component in component browser 
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• Context menu in Modelica Text layer 
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• Context menu of component in diagram layer 

 

Closing of tabs 

Clicking the red cross of a tab closes it. If a model that is displayed in a tab is unloaded, the 
tab is also closed.  

  



 

 Dymola 2016 Release Notes 13 

Context menu of tabs 

Each tab has a context menu: 

 

List of tabs 

A list of the tabs is available to the right in the tabs toolbar: 
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Display of tabs 

The display of tabs can be controlled by the command Window > Tools: 

 

Changes of other navigation commands due to the new tabs 

Due to the new tabs, the Previous and Next buttons have changed to display “previous” and 
“next” in the active tab. 
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Instance hierarchy 

In Dymola 2016, a toolbar displaying the instance hierarchy to the opened component is 
displayed in the upper left of the main window: 

 

You can navigate by clicking in the instance hierarchy toolbar, for example: 

 

 

If the top level is open, the Dymola icon to the left is displayed dimmed (see figure in 
previous section). 

The display of instance hierarchy can be controlled by the command Window > Tools: 
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3.2.3 Searching connections and connected 
components 

In large models with expandable connectors it might be hard to see where signals are created 
and used. To facilitate investigating such models you can search connections, and the 
corresponding connected components, by the command Find Connection from the context 
menu of a connection in the diagram layer. 

The search lists the connectors grouped by the connector type. 

An example of  a search: 
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Some features of the command: 
• The search is based on what is shown in the diagram layer when starting the search. 
• Clicking a result will select the corresponding component; if the component is inside 

another component than the one displayed, the Show Component command is used 
automatically to display the diagram of that component to select the searched 
component. This navigation does not influence the search; you can still select another 
component. You can go back to the original zooming by clicking the button after Find 
connection in component. 

The command is also always available as Edit > Find Connection.  

Find Connection is also available in simulation mode. 

3.2.4 Drag & Drop of classes in the package browser 
In Dymola 2016, classes in the package browser can be dragged and dropped; this makes for 
example rearranging of the classes in a package more convenient. 

When dragging a class to a location in another top level package than where the class 
resides, the Move Modelica Class dialog is opened, to let the user use this dialog to 
conclude the moving of the class. 

Furthermore: 
• Pressing Ctrl while dragging gives copying. If the class is dragged to a location in 

another top level package than where the class resides, the Copy Modelica Class 
dialog is opened, to let the user use this dialog to conclude the duplication of the class. 



 

18 

• Cut, Copy and Paste are available in the package browser. These commands work the 
same as drag and drop. 
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3.2.5 Improved Modelica Text editor 

Mathematical Notation in toolbar 

The mathematical notation of the Modelica Text editor is now reached by a Mathematical 
Notation button in a new toolbar of the editor. The previous context command has been 
removed. 

 

To go back to the ordinary Modelica Text, a Modelica Text button is available in the 
toolbar. 

3.2.6 Improved documentation layer 

Improved navigation between editors 

Buttons for editors improves the navigation between layers; context menus for navigation 
are not used anymore. 
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The above is the default; the formatted documentation layer, without any editing 
possibilities. 

Clicking Info Editor  gives the info editor (given the class is not read-only): 

 

Clicking Info Source  gives the HTML code of the info editor. Changes can only be 
made if the class is not read-only. 

 

Clicking Revisions Editor  or Revisions Source  gives the revision 
editor/HTML code of revisions, respectively. 

Improved documentation editor 

Any of the commands Info Editor  or Revisions Editor  gives a documentation 
editor. The editor has been enhanced with a number of new features: 
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Font (1) and font size (2) 

    

Concerning font size, it is possible to enter a value directly in the box, or to edit an existing 
one. 

Subscript/Superscript (3) 

Clicking any of these gives subscript/superscript for the selected text. 

Text color/background color (4) 

Using these buttons text and background color can be selected. 

Clicking the arrow of any of these buttons gives a color selection menu (the example below 
is for the background): 
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Here any basic or custom color can be selected. Custom colors can be added by using the 
color definition boxes to the right, then clicking Add to Custom Colors. 

Selecting a text and then setting the color of the text or background, will also define the 
color selection as default, and change the color under the button accordingly. If the default 
color selection is to be used, it is sufficient to just click the button when a text is selected, to 
get the default color. 

Decrease/Increase indent (5) 

Insert Table (6) 

The number of rows and columns are selected by the mouse. 

 

A context menu in the created table enables adding/removing columns and rows: 
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3.2.7 Improved Used Classes layer 

Improved coverage for Flat Modelica 

In Dymola 2016, the following items have been added to the Flat Modelica representation: 
• Media packages 
• Connectors 
• Partial models 
• Functions 
• Type and other short class definitions 
• Attributes of inherited classes (e.g. buses) 

In particular, the support of Flat Modelica for media packages makes it possible to display 
the code for used media functions, this was previously not possible. 

Flat Modelica in toolbar 

Flat Modelica is now available as a Flat Modelica button in a new toolbar. The 
corresponding command in the context menu has been removed. 

 

Going back to ordinary display of Used Classes is done by clicking the Used Classes 
button in the toolbar. 

3.2.8 Support for including resources in Save Total 
The command File > Save Total… has been extended to include used resources. Whether to 
include resources is decided by selecting type of file to save: 
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The new alternative Modelica Zip-archive with resources (*.zip) generates one zip file 
with the active class, and all used classes – and resources. 

Unzipping the zip archive and opening the main .mo file inside will also include the 
resources, in particular the following scenarios now work: 
• A model using tables in Modelica Standard Library 3.2.1. 
• A model using images from the resource directory. 
• A model using dxf files from the resource directory for animation. 

There are two flags that can be used to include documentation/images in the zip file – the 
default is not to include documentation/images, since this is memory-consuming. 

• Advanced.SaveTotal.CopyDocumentation – this flag can be set to true if 
documentation should be included in the zip directory. “documentation” is here defined 
as directories named Documentation or files with suffix pdf, ppt, doc, docx, html, ott, 
and css. The flag is by default false. Note that other file formats than the ones listed are 
always included, e.g. files with suffix pptx. 

• Advanced.SaveTotal.CopyImages – this flag is by default true, meaning that 
images are by default included in the zip directory. “images” is here defined as 
directories named Images, or files with suffix png or gif. If images should not be 
included, the flag can be set to false. Note that other file formats than the ones listed are 
always included, e.g. files with suffix stl and jpg. 
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Note. Save Total with resources on Linux requires the Linux utility “zip”. If not already 
installed, please install using your packaging manager (e. g. apt-get) or see e. g. 
http://www.info-zip.org. 

3.2.9 Minor improvements 

Toolbar button for “New” 

 

A new button is available in the upper toolbar, to facilitate creating a new item easily. 
Clicking on the arrow displays the alternatives above, clicking the button displays the dialog 
for creating a new model. 

Selectable action when double-clicking a component 

The default action when double-clicking a component is to display the parameter dialog. 
This action can be changed to instead activating the command Show Component. The 
selection is made by using the command Edit > Options…, the Appearance tab: 

http://www.info-zip.org/�
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The setting is stored by the flag Advanced.ComponentDoubleClickAction and is saved 
when saving settings. 

Undo available for Split Model 

Edit > Undo or Ctrl+Z now also work when you have used the Split Model command to 
create a submodel or copy to base class. (When you have used the command Split Model > 
Copy to model, undo does not work, but for this command it is easy to just remove the 
created model.) 

Edit > Redo or Ctrl+Y work as well. 
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Copy/Paste from matrices in e.g. Microsoft Excel to Dymola matrix editor 

A new context command button Paste Matrix is available in the matrix editor to insert table 
cells copied from Microsoft Excel or Matlab. 

 

If the number of rows and columns of the cells to paste is not the same as the number of 
rows and columns in the existing matrix, a warning is issued. 

Improved bus signal tracing 

The tracing of bus signals (expandable connectors) that was introduced in Dymola 2015 
FD01 has been further improved; longer bus signal names are used to clarify what signal is 
presented. 

Note also the use of the new command Find Connection (see section “Searching 
connections and connected components” on page 16). 

Changed annotation LinePattern.None in connect annotations 

In Dymola 2016 the annotation LinePattern.None in connections or lines is changed to 
mean that such items are hidden.  

To convert such annotations to instead display them (the previous behavior), the new built-
in function updateModelicaAnnotations("packageName") can be used, where 
packageName is the name of the package to be converted. 

Mnemonics updated to be consistent with other Microsoft Windows 
applications 

The mnemonics (using keyboard keys to navigate in the command menus) have been 
updated to be consistent with other Microsoft Windows applications. 

More default colors for text objects 

Brown, Orange, and Purple have been added to the default color selection for graphical text 
objects. 
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Removed subheader in the component browser 

In order to save useful space, the subheader “Components” has been removed from the 
component browser. 

3.3 Simulating a model 

3.3.1 Plot dependencies 
In Dymola 2016 it is possible to display the dependencies of a selected variable by plotting 
them. This facilitates browsing of results to understand the behavior for normal simulations, 
as well as debugging it. 

Introduction 

Dymola converts the differential-algebraic system of equations symbolically to differential 
equations in state-space form, i.e. solves for the derivatives. The steps include index 
reduction and state selection.  

Efficient graph-theoretical algorithms are used to determine which variables to solve for in 
each equation and to find minimal systems of equations to be solved simultaneously 
(algebraic loops). Thus the problem of calculating the derivatives and all other variables but 
the states at a time instance is a sequence of problems that can be solved in turn. (See further 
Section 8.8 “Symbolic Processing of Modelica Models” in the manual “Dymola User 
Manual Volume 2”.) 

It means that a computational causality has been assigned to the variables and the equations. 
Such a subproblem may be a scalar problem consisting of one scalar variable and one 
equation. It may be several variables assigned by a record equation, an array equation, a 
multi-returning function or an algorithm. In the general case, it is mixed system of equations 
including Boolean, integer and real variables. All unknown variables to be solved for from 
the equations depend in the general case on all other time-varying variables appearing in the 
equations of the subproblem. Thus these variables are considered to be depend of each 
unknown of the subproblem. The dependet variables are all calculated from subproblems 
appearing earlier in the sorted sequence of subproblems. 

By plotting the dependencies of a variable and recursively plotting their dependencies, it 
would hopefully be possible to understand or identify the reasons or origin of observed 
behaviors. 

Below an example is given to illustrate this. 

As described below it is simple have the behavior of the dependency variables of a time 
dependent variable, v, plotted. 

When plot of dependencies are activated, the simulation will also store the behavior of 
protected variables. 



 

 Dymola 2016 Release Notes 29 

The legend includes the equation from which the variable is calculated, however, in case the 
variable is solved from an algebraic loop, no explicit equation are given, but it is indicated 
whether it is a linear, nonlinear or mixed system of equations. 

Simple equations v1=v2 are frequent in Modelica models due to connections. Such 
equations are exploited by Dymola to eliminate the variable from the calculation and turn it 
into an alias variable to allow it to be plotted. Plotting of its dependencies is supported. If v1 
= v2 is used to eliminate v1, then if v2 is solved from a simple equation v2 = e, then the 
legend will be v1 = v2 = e; and the incidences of v2 are plotted. In other more complicated 
cases the legend will be v1 = v2 and v2 will be displayed to allow further traversing of the 
dependencies. 

It is also possible to plot the dependencies of a continuous-time state, x. It gives the 
dependencies of its derivative, der(x) and the equation displayed in the legend is 
“x=Integral(der(x))”. 

Applying plot dependencies 

To enable plotting of dependencies, the setting Provide variable dependencies for 
plotting must be ticked in the simulation setup, before running a simulation. The setting can 
be reached by the command Simulate > Setup…, the Translation tab. 

 

This setting corresponds to the flag Advanced.GenerateVariableDependencies = 
true;. By default the setting is unticked, and the flag is false.  

Note that this setting also automatically activates storing of all types of variables, 
corresponding to the settings in the two groups Store and Store additional variables, in the 
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Output tab in the simulation setup, independently whether those settings are seen as 
activated in the tab or not. 

To display the dependencies for a variable in a model, simulate the model, then right-click 
the variable in the variable browser, and select Plot Dependencies.  

 

Note that you can also display the dependencies for a variable by right-clicking the 
corresponding curve and select Plot Dependencies from the context menu. 

A new plot window is displayed; the variable and dependencies are plotted in the new 
window. If more than 20 curves are to be displayed, more windows are opened, with a 
maximum of 20 curves in each. This maximum number of 20 curves per window can be 
changed by the flag Advanced.DependenciesPerPlot. 

The heading of the plot window is the equation of the variable.  

A simple example, for the variable axis1.gear.gear.flange_a.tau in the Robot demo 
(corresponding to the selection in the above figure): 
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The variable for which the dependencies are plotted is dashed in the plot. 

Notes: 
• The feature of dragging curves between plot windows and diagrams – this feature can 

be useful for the plot dependency windows. See section “Drag & Drop of curves 
between plots/diagrams” on page 35 for more information. 

• There might be a number of plot windows after a while. You can close them all by the 
command Window > Close All Windows. 
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An example 

Running the demo CoupledClutches (File > Demos > Coupled clutches) we notice that the 
acceleration of the mass J3 jumps at certain times: 

 

Let us investigate the change of acceleration at t=0.79. First we plot the dependencies for 
J3.a, (easiest done by right-clicking the curve and select Plot Dependencies) then we can 
center the result on t=0.79 by zooming around that time (by Shift+drag). 

Having the result, we pause over the curve legends, one legend at the time, to see each 
variable highlighted in the plot, until we find something interesting: 
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Plotting the dependencies for clutch1.mode (and zooming, and arranging the legends to the 
right using the plot setup menu), we get: 
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We realize that the change was due to clutch1.w_rel reaching zero and the clutch switching 
to stuck mode. 

Note that double-clicking the equation in the header displays it in a more user-friendly way: 
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3.3.2 Plot window 

Drag & Drop of curves between plots/diagrams 

Curves can be dragged and dropped between plots or diagrams by dragging and dropping 
the curve legend: 

 

Signal operators are included, if any. 

Note that you can drag several curves at the same time, by first clicking several curve 
legends, and dragging them. 
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Multiple vertical axes in plot window 

Two vertical axes are supported in the plot window, one to the left (the primary one) and 
one (secondary) to the right. 

 

Gridlines are drawn for the primary axis only. 

Plotting always uses the primary (left) axis by default. To use a secondary axis for a variable, 
right-click the curve and select Right Vertical Axis from the context menu: 
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You can also use the plot setup, reached by right-clicking and selecting Setup… (Or use the 
command Plot > Setup…), in particular to move multiple variables to the secondary axis. 

In the plot setup, in the Variables tab, select one or more variables, and then, in the Vertical 
axis combo box, select Right Axis. The variable(s) will be associated with the secondary 
axis to the right. If such an axis does not exist, it will be created. 
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To edit title to the secondary axis (variable description being default), use the Vertical axis 
title (optional right axis) group in the Titles tab in the plot setup. 
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To edit the range of the secondary axis, use the group Vertical range (optional right axis) 
in the Range tab of the plot setup. 
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Manual tuning can be made here to match the two y-axes. 

Concerning scripting, see below. 
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Filled background for signal operator labels selectable 

To increase the visibility of signal operator labels when they for example overlap curves, 
filled background can be selected for them. 

Filled background for a signal operator label can be selected when editing a signal operator 
by double-clicking on it: 

 
Filled background for the label can also be changed using the context menu for the signal 
operator: 

 
The default is no background for the signal operator label. 
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Easier access to change curve color, line style, marker style, and 
thickness 

Setting color, line style, marker style, and thickness of curves can now be done from the 
context menu for a curve or a legend, without entering the plot setup. 

 

Command for selection of all curves in a diagram 

A new context command is available in the diagram, Select All. The command selects all 
curves in the diagram. 
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The command is also available as Edit > Select All, if a plot window is selected. 

The command can be valuable when working with many curves (for example working with 
plot dependency); selecting all curves, then deselecting some by clicking them, and then 
dragging the selected one to a new plot window might be a typical action. 

Legend name can be changed by double-clicking the legend 

Double-clicking a legend brings up a menu for changing the name. 

 

More default colors 

Brown, Orange, and Purple have been added to the default color selection for curves and 
text objects in plots, see image above for curves. 

Auto assign of line styles after colors, instead of marker styles after 
colors, for additional curves 

In Dymola 2016 line styles are auto assigned for additional curves when all default colors 
are used. Previously marker styles were used. 
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3.3.3 Command window 

Improved editing in the command window 

 

Improvements of the HTML editor improve the editing in the command window; for 
improvements, see section “Improved documentation editor”, starting on page 20, for details. 

3.3.4 Scripting 

Signal operators available for plotted arrays like FFT (Fast Fourier 
Transform) in scripting 

If a legend is specified for a plotted array, this legend can be used by the built-in function 
plotSignalOperator to plot signal operators for the plotted array. 

As an example calculating max on an FFT, consider a script like (given that the demo 
Coupled Clutches is simulated before running the script): 

createPlot(1, subPlot=2, erase=false, grid=true, leftTitleType=2, leftTitle="Amplitude",  
   bottomTitleType=2, bottomTitle="Frequency (Hz)"); 
(freqPart, powers) = SignalOperators.Fourier.calculateFFT("CoupledClutches.mat",  
   {"J1.der(w)"}, 0, 1.2, 501, 50, SignalOperators.Windows.Windowing.Rectangular); 
plotArrays(freqPart, powers, legend={"J1.der(w)"}, id=1, title="Frequency Analysis (FFT)"); 
plotSignalOperator("J1.der(w)", SignalOperator.Max, 0, 30, 0, 1); 

(This script is actually created by creating the FFT and signal operator by GUI, and then 
making a script from the output in the commands window.) 

The result is: 
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Support in scripting for multiple vertical axis in plot window 

Several script commands for plotting have been updated to support multiple vertical axes, 
for example createPlot(), plot() and plotArray(). The details can be found using 
the “help” command; a simple example plotting w on the left axis and tau on the right is: 

plot({"J1.w","J1.flange_b.tau"}, axes={1,2}); 

Managing Modelica path settings from within Dymola 

A new built-in function can be used to manage the Modelica path (MODELICAPATH) 
from within Dymola: 

AddModelicaPath(path, erase=false); 

The function appends a directory, specified by the string variable path, to the Modelica 
path (unless erase=true). 

An alternative is to use  
Modelica.Utilities.System.setEnvironmentVariable("MODELICAPATH", 
"…"); 

Notes: 
• The menus File > Libraries and File > Demos are now rebuilt after a change of 

MODELICAPATH. 
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• To keep the change of Modelica path between sessions, this function has to be added 
in setup.mos. It is currently not possible to store the change of the Modelica path from 
GUI. 

Changing the default directory 

To change the default directory, a new built-in function has been added: 
ChangeDefaultDirectory(path); 

The function changes the default working directory of Dymola from …My 
Documents\Dymola to the value of the string variable path. 

The difference from the built-in function cd is that the new function is ignored if Dymola is 
started from a short-cut starting in another directory than the default directory …My 
Documents\Dymola. 

Note. To keep the change of default directory between sessions, this function has to be 
added in setup.mos. It is currently not possible to store the new default directory from GUI. 

3.3.5 Minor improvements 

Improved compiler selection 

In the 64-bit version of Dymola, the flag Advanced.CompileWith64 for setting if models 
should be compiled as 32-bit or 64-bit executables, has been improved. The default value 0 
of the flag now also adapt to existing version of external libraries – if external libraries only 
exist as either 32-bit or 64-bit, the variant that allows linking is automatically selected. 
However, dymosim.dll is always compiled as 64-bit. 

Furthermore, the messages in the log have been improved, with e.g. warnings that libraries 
corresponding to a certain setting do not exist. 

Source code generation features for normal translation 

More readable, traceable and efficient code for e.g. debug purposes can be generated by 
normal translation, if a specific flag is set. See the corresponding section in “Source Code 
Generation” starting on page 55 for more information. 

Improved support for high resolution images from animations 

To obtain high resolution images from animation, the flag 
Advanced.ExportAnimationWidth can be set to the wanted width for the exported 
bitmap image (an example is Advanced.ExportAnimationWidth=750;). Having set 
this flag, and then generated the animation, the animation image can be exported by 
selecting the animation window, and then using the command File > Export > Image…. 

The flag is by default 0, meaning that the flag is not used. The flag is not stored between 
sessions. 



 

 Dymola 2016 Release Notes 47 

Parallelization improvements 

When using external functions in parallel code it is now by default not assumed that the 
functions are thread-safe; this means that all external function calls are seen as a critical 
region, and only one external function will execute at the same time. 

This avoids unpredictable results, at the cost of efficiency. If you are certain that a specific 
external function is thread-safe, you the override the above for this function, with the 
following annotation in the external function: 

annotation(__Dymola_ThreadSafe=true); 

If the external functions are in a read-only library, you can set the flag 
Advanced.ExternalFunctionCritical = false; 

to indicate that the external functions are by default thread-safe – and to get the same 
behavior as in previous versions of Dymola. 

In addition you can use the annotation 
annotation(__Dymola_CriticalRegion="CLanguageIdentifier"); 

This indicates that the function is not thread-safe, and will create a named critical region. 
This ensures that only one external function with the same identifier will execute at the same 
time (but other functions may execute in parallel) - regardless of the setting of 
Advanced.ExternalFunctionCritical.  
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3.4 Installation 
For the current list of hardware and software requirements, please see chapter “Appendix – 
Installation: Hardware and Software Requirements” starting on page 68. 

3.4.1 Installation on Windows 

Compilers 

Compiler performance improvements 

The Visual Studio 2013 and 2012 compilers generates a bit less efficient code than previous 
versions of the compiler, with the selected optimization settings. Dymola´s code generation 
has been tuned to avoid this problem. 

You can still set the flag 
Advanced.Define.GlobalOptimizations = 2; 

before generating code, to activate the global optimization in the compiler, but the effect on 
the simulation performance is now small for all versions of the compiler. (The default value 
of the flag is 0.) Note that although the simulation performance is somewhat improved 
setting this flag, the compilation of the code may take substantially longer time for large 
models. The setting corresponds to the compiler command /Og. 

Extended GCC compiler support 

In Dymola 2016, the following enhancements have been implemented: 
• Support for 64-bit GCC. 
• Support for FMU export. 

Currently supported GCC versions (and compatibles) are: 

• 32-bit: MinGW GCC 4.8.1. 

• 64-bit: MinGW GCC 4.9.2. 

To download any of these free compilers, please visit http://www.Dymola.com/compiler 
where the latest links to downloading the compilers are available. Needed add-ons etc are 
also specified here. Note that you need administrator rights to install the compiler. 

Current limitations with 32-bit and 64-bit GCC: 
• Embedded servers (DDE or OPC servers) are not supported. 
• Commercial libraries: Only limited testing has been done. 
• Support for external library resources is implemented, but requires that the resources 

support GCC, which is often not the case. 
• No support for run-time license. 
• For 32-bit simulation, parallelization is only supported with any of the Lsodar, Dassl, 

Euler, Rkfix2, Rkfix3, or Rkfix4 algorithms. 

http://www.dymola.com/compiler�
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Notes on GCC compiler selection: 

 

• If the default path must be changed, browse for the gcc.exe file. 

Redundant license servers 

Already in the previous version of Dymola, three license servers could be entered, separated 
by space, if redundant license servers were needed. Note that only one or three servers are 
supported. 
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Improved language handling, in particular for Japanese 

In Dymola 2016, the selection of translation file for Dymola is by default based on the 
regional language setting. For Japanese, the previous installation option Japanese 
translation has been removed. 

Currently only English and Japanese are available in Dymola. 

If the regional language setting should not be used, there are two ways of overriding it. 

The first is to use a command line setting of the language: -translation <language>. 
Two examples are important: 
• A customer that wants to run Dymola in Japanese on a machine with regional 

language setting other than Japanese. This can be done by starting Dymola with the 
command “C:\Program Files (x86)\Dymola 2016\bin64\Dymola.exe” –translation ja 
(given using a 64-bit Dymola from the default location).  

• A customer that wants to run Dymola in English on a machine with regional language 
setting Japanese. This can be done by starting Dymola with the command 
“C:\Program Files (x86)\Dymola 2016\bin64\Dymola.exe” –translation none (given 
using a 64-bit Dymola from the default location). 

The second way to override the default selection of translation file is to specify what 
translation file to use, this can be done with the command line option  
–translationfile "<filename.qm>" when starting Dymola. One specific opportunity 
here is to use a translation file other that the one in the Dymola distribution. The file can be 
located anywhere on the machine, since the command line option demands the path of the 
file to be specified. An example could be to start Dymola with the command  
“C:\Program Files (x86)\Dymola 2016\bin64\Dymola.exe” –translationfile ”E:\Extra\ 
NewJapaneseTranslationFile.qm” (given using a 64-bit Dymola from the default location, 
and a translation file NewJapaneseTranslationFile.qm located in E:\Extra). 

Note that command line options can be included in operating system shortcuts to Dymola. 

Japanese keyboard support improved 

In Dymola 2016, the Japanese keyboard IME toggle key is supported, if the environment 
variable DYMOLA_KEY_SPECIAL is set to either * or 123. 

3.4.2 Installation on Linux 

Redundant license servers 

The same feature as for Windows apply, see above. 

Japanese keyboard support improved 

The same support is valid as for Windows, see above. 
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3.5 Model Management 

3.5.1 Licensing libraries 
Licensing of third party licenses for node-locked licenses already available, Dymola 2016 
supports also licensing of third party libraries for sharable licenses. Note that this feature 
currently is only available on Windows. 

Third party library vendors, please contact you support channel/sales representative for 
additional information, documentation, and examples. 

3.6 Other Simulation Environments 

3.6.1 Dymola – Matlab interface 

Compatibility 

The Dymola – Simulink interface now supports Matlab releases from R2010a (ver. 7.10) up 
to R2014b (ver. 8.4). Only Visual Studio C++ compilers are supported to generate the 
DymolaBlock S-function. The LCC compiler is not supported. 

3.6.2 Real-time simulation 

Compatibility – dSPACE 

Dymola 2016 generated code has been verified for compatibility with the following 
combinations of dSPACE and Matlab releases. 

dSPACE DS1005 and DS1006 platforms 
• dSPACE Release 6.6 with Matlab R2010a 
• dSPACE Release 7.0 with Matlab R2009bSP1 and R2010bSP2 
• dSPACE Release 7.1 with Matlab R2011a 
• dSPACE Release 7.2 with Matlab R2011b 
• dSPACE Release 7.3 with Matlab R2012a 
• dSPACE Release 7.4 with Matlab R2012b 
• dSPACE Release 2013-A with Matlab R2013a 
• dSPACE Release 2013-B with Matlab R2013b 
• dSPACE Release 2014-A with Matlab R2013b and R2014a 
• dSPACE Release 2014-B with Matlab R2013b, R2014a, and R2014b 

SCALEXIO 
• dSPACE Release 7.4 with Matlab R2012b 
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• dSPACE Release 2013-A with Matlab R2013a 
• dSPACE Release 2013-B with Matlab R2013b 
• dSPACE Release 2014-A with Matlab R2013b and R2014a 
• dSPACE Release 2014-B with Matlab R2013b, R2014a, and R2014b 

The selection of supported dSPACE releases focuses on releases that introduce support for a 
new Matlab release and dSPACE releases that introduce a new version of a cross-compiler 
tool. In addition, Dymola always support the three latest dSPACE releases with the three 
latest Matlab releases. Although not officially supported, it is likely that other combinations 
should work as well. 

Compatibility – xPC Target 

Compatibility with Matlab xPC Target has been verified for all Matlab releases that are 
supported by the Dymola – Simulink interface, which means R2010a (xPC Target ver. 4.3) 
to R2014b (Simulink Real-Time ver. 6.1). Only Microsoft Visual C compilers have been 
tested. 

3.6.3 OPC Communication 
The support for OPC communication now also includes the Visual Studio 2012 compiler; 
presently Visual Studio 2008, 2010, and 2012 compilers are supported. 

3.6.4 Java Interface for Dymola 
The Java interface for Dymola was previously only supported on Windows; it is now also 
supported on Linux. 

3.6.5 FMI Support in Dymola 
Unless otherwise stated, features are available both for FMI version 1.0 and version 2.0. 

Multiple instantiation of an FMU supported 

FMUs generated by Dymola 2016 support multiple instantiation. This means that the same 
FMU can be used several times in the same model. 

The generated XML files are now also updated to correctly indicate that the model can be 
instantiated multiple times. 

Restrictions: 
• Multiple instances are currently not supported for co-simulation with Dymola solvers. 
• The old table handling, corresponding to tables in previous versions of Modelica 

Standard Library (3.2 or older) is not supported. If you have user models with such old 
table handling, those must be updated to use this feature. 

The support for multiple instances has a run-time cost; you can therefore disable the support 
for multiple instances by setting the flag (the flag is by default true): 

Advanced.AllowMultipleInstances = false; 



 

 Dymola 2016 Release Notes 53 

Enhanced FMI support in Simulink 

FMU export from Simulink 

A new and enhanced version (2.0) of the Dassault Systèmes FMU Export from Simulink 
package is available. The new version supports: 
• FMI versions 1.0 and 2.0 
• Model Exchange and Co-simulation 
• Co-simulation export with Simulink fixed-step solvers 
• Matlab/Simulink R2010a – R2014b (32-bit and 64-bit) 
• Visual Studio 2008 and later C compilers 
• General enhancements and reduced limitations, including support for all data types 

supported by Simulink (including signed/unsigned integers and boolean). 

 

The FMU Export from Simulink package is located in the Mfiles folder of the Dymola 
2016 distribution as rtwsfcnfmi.zip. See the README file in the package or consult 
the Dymola manual for installation and usage instructions. 

The package can be used for free without any associated license.  

Support and maintenance is offered to Dymola customers through the regular support 
channel at www.3ds.com/support. 

FMU export supported on GCC compilers on Windows 

FMU export is now supported for GCC compilers on Windows. For more information about 
GCC, see section “Extended GCC compiler support” on page 48. 

Note that FMU export is already supported on GCC on Linux.  

http://www.3ds.com/support�
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Including protected variables in modelDescription.xml 

Protected variables are by default not included in modelDescription.xml when using FMU 
export, but can be included by setting the flag 

Advanced.FMI.xmlIgnoreProtected = false; 

The flag is true by default. 

Import of FMUs of FMI version 1.0 and version 2.0 to the same model 
supported 

In Dymola 2016, import of both FMUs of FMI version 1.0 and version 2.0 to the same 
model is supported. 

Improved display of information for an imported FMU 

Information from the modelDescription.xml file of an imported FMU is now displayed in 
the information layer of the imported FMU. 
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3.6.6 Source Code Generation 

Multi-threaded code and model export 

Instantiation of multiple FMUs supported 

FMUs generated by Dymola 2016 support multiple instantiation. See “Multiple instantiation 
of an FMU supported” on page 52. 

Disable compilation 

A new flag is now available; if compilation of a generated executable is not of interest, the 
compilation can be disabled by setting the flag 

Advanced.CompileAfterTranslation=false 

This will save some time. However, note that the compilation can detect some potential 
errors. 

Source code generation features for normal translation 

A new flag is available to be able to obtain the same features for normal translation as for 
source code generation when it comes to creating more readable, traceable, and efficient 
code that can be used for debug purposes.  

These features correspond to the flags 
Advanced.UseModelicaNamesForC 
Advanced.OutputEquationTrace 
Advanced.SubstituteVariablesUsedOnce 

To be able to activate the corresponding features for normal translation, set 
Advanced.SourceCodeExportNormal=true 

The flag is by default false. 

Note. To be able to use this flag: 
• You must have the SourceCodeGeneration license option. 
• Code export must not be disabled in Help > License…, the Details tab.  
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3.7 Advanced Modelica Support 

3.7.1 External functions in other languages 

C: linking with DLLs without wrapper libraries supported 

In Dymola 2016, linking directly with a dll (without import-library) is supported also for 
Windows (it was previously supported for Linux), when all the following is fulfilled: 
• The specified lib-file does not exist. 
• A corresponding dll-file exists. 
• There is an external function call. 
• There is no include-annotation. 
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3.8 New libraries 

3.8.1 Human Comfort Library 
The Human Comfort Library was developed within the European research project 
EuroSysL-D and provides basic models to estimate the human comfort within an air 
conditioned zone, in the form of mathematical criteria, and also graphical visualization. 
Furthermore, zone models, (e. g. for buildings) are established to apply the Human Comfort 
library for the design and optimization process of air conditioning systems for mobile and 
stationary applications. 

Introduction 

 

Today most air conditioning applications, especially when integrated in complex energy 
management systems, are obtained with respect to energy efficiency and stable supply. 
Besides these “hard factors” for evaluation of an air conditioning system there is the fuzzier 
concept of the human comfort. A number of investigations are dealing with this issue. The 
basic standards of the Human Comfort library are: 
• DIN EN ISO 7730 
• ASHRAE Standard 55 
• Dutch Thermal Comfort Guideline. 

Using these standards it is possible to quantify the individual and subjective comfort my 
means of characteristic numbers and standardized mathematical models. 
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It is one of the primary aims of the Human Comfort Library to provide the user with a 
powerful and intuitive Modelica library to analyze the thermal comfort within enclosed 
rooms. 

To achieve this goal a close contact was held with industrial companies throughout the 
design and implementation phase, to match the user´s expectations and needs. 

In result of this process the Human Comfort Library provides: 
• A framework compatible with the Modelica Standard Library, in particular the 

package for fluid flow modeling and control design. 
• Fundamental functions and models for the analysis and visualization of human 

comfort. 
• Concepts for the description of the occupant´s activity (metabolic rate) and clothing. 
• Fundamental models for the description of air conditioned zones like rooms, aircraft 

and automotive cabins. 

 

• An extensive set of examples discussing and illustrating the main features of the 
library. 

• Base classes for the definition of weather data based either on measurement or user 
definition. 
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On the base of the standards mentioned above, the human comfort can be quantified (and 
thus visualized, too). This leads to the following evaluation parameters: 
• PMV – the Predicted Mean Vote 
• PPD – Predicted Percentage of Dissatisfied 
• GTO – Calculation of weighted temperature exceeding hours 
• TO25/TO28 – Calculation of temperature exceeding hours 

All of those evaluation criteria can be used for visualization by use of easy-to-use models. 
This allows the user to get a detailed overview of the system of interest for an effective and 
intuitive interpretation of simulation results. 

 

Library structure 

Essential packages of the library are: 
• HumanComfort Package (Calculation and visualization of human comfort variables) 
• Zones Package (Zone models for rooms, vehicle cabins, and aircraft cabins) 
• Weather Package (Models for supplying weather data). 
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3.9 Updated libraries 
Below is a short description of updated libraries. For a full description, please refer to the 
libraries documentation. 

3.9.1 Air Conditioning Library 
A new version 1.10 has been released. 

New features 
• Introduction of a new system component System_ACL. Including this system 

component at the top level of a model makes it possible to set system settings, which 
will be propagated to component models using the inner/outer principle. A 
System_ACL component with its default values will not affect the behavior of the 
model. System_ACL will automatically be added to the translated model if it is not 
done by the user. 

• The refrigerant connector variables are changed; the enthalpy flow rate is replaced by 
a specific enthalpy stream variable, in order to avoid discontinuities when accessing 
upstream enthalpy at zero-flow. It gives access to specific enthalpies in neighbor 
volumes independent of flow direction; previously only the upstream value could be 
accessed from inside a component. 

Improvements 
•  New shut-off variable u in refrigerant pressure loss models. By default this value is 1 

and will not affect any result. By setting this variable equal to e.g. an output signal 
from a ramp, it is possible to shut off the flow. 

• New Boolean parameter generateEventAtPhaseTransition. Its value can be set in the 
System_ACL and is by default false. Setting this value to true will trigger an event 
when a phase transition occurs in a control volume. 

• New Boolean parameter generateEventAtCritical. Its value can be set in the 
System_ACL and is by default false. Setting this value to true will trigger an event 
when a control volume enters or exits the supercritical zone. 

• New Boolean parameter positiveFlow. Its value can be set in the System_ACL and is 
by default true. Setting this value to true will assume a positive flow direction. 

• Differentiating scheme option for the discretized refrigerant pipes. The scheme can be 
changed in System_ACL. It is possible to use a hybrid scheme which includes 
diffusion effects at low flow rates. The diffusion factor can be set in different ways. 
One option permits the variation of the diffusion factor in the function of the mass 
flow. 

• StateSelection option for using pressure difference instead of pressure as state 
variable, accessible in System_ACL. 

• Introduction of new pressure loss correlations with the possibility to switch to a 
simplified model during simulation. 
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Conversion of user libraries 

No conversion script is needed. However, any customized components may need to be 
adjusted due to the newly added stream variable in the two-phase flow connector. 

3.9.2 Design Library 
A minor version 1.0.4 has been released; the integrator CVODE is now supported in the 
calibration settings. 

3.9.3 Electric Power Library 
A new version 2.2.1 has been released, with minor changes. 

Automatic conversion of user libraries from version 2.2 is supported using the included 
conversion script. 

3.9.4 Engine Dynamics Library 
A new version 1.2.3 has been released, with improved Modelica compliance. 

No conversion of user libraries is needed. 

3.9.5 Flexible Bodies Library 
A new version 2.2.1 has been released; the library now supports both 32-bit and 64-bit 
versions on Windows and Linux. 

3.9.6 Fuel Cell Library 
A new version 1.3.1 has been released. 

New features 
• Stoichiometries in membranes, burners and reactors are now calculated from the 

stoichiometry and stoichiometryMatrix functions in the ReactionGas media. 

Improvements 
• Improved structure of FuelCell.Media.ReactionGas.ReactionProperties for increased 

readability. p, T, and X are now inputs. 
• Added possibility to parameterize flow and temperature boundaries in 

FuelCell.Sources with enthalpy instead of temperature. Default behavior is the same as 
in earlier versions, i.e. parameterization with temperature. 

• The Index record is no longer part of FuelCell.Media.Templates.ReactionGas, it is 
replaced by the use of the substanceIndexVector function in media. 

• Moved gibbsReactionEnergy function to ReactionGas template. 
• Improved Modelica compliance. 
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Conversion of user libraries 

Automatic conversion of user libraries from version 1.3 is supported using the included 
conversion script. 

3.9.7 Heat Exchanger Library 
A new version 1.3 has been released. 

New features 
• The following new plate heat exchanger components are available, to be used in both 

counterflow and co-flow: 
o Gas-liquid with plain plate surface. 
o Gas-liquid with Chevron plate surface.  
o Liquid-liquid with plain plate surface. 
o Liquid-liquid with Chevron plate surface. 
o Gas-gas with plain plate surface. 
o Gas-gas with Chevron plate surface. 

• Test benches for plate heat exchangers: gas-gas, liquid-gas, and liquid-liquid. 
• A set of heat transfer and pressure drop correlations for Chevron plate heat 

exchangers. 
• A new two-phase/air flattube heat exchanger component which contains a receiver 

after a given pass. 

Improvements 
• Improved library documentation, in particular for the Kandlikar correlation. 
• Improved Modelica compliance. 

Conversion of user libraries 

Automatic conversion of user libraries from version 1.2 is supported using the included 
conversion script. 

3.9.8 Hydraulics Library 
A new version 4.2 has been released. 

New features 
• Four new library examples are available: HatchCover, HydraulicLift, PumpAndMotor, 

and WaterHammer. 
• A completely new User´s Guide for Elements in Hydraulics.Elements.Information. 
• A new Hydraulic.Elements-component: PilotedCheckValve. An example model 

demonstrating this component is also included. 
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• A new pressure source Sources.PressureSource with time dynamics, replacing the old 
Sources.ControlledPressureSource. 

• Cavitation warnings now print the component name in the simulation log. 
• It is now possible to parameterize ThermoHydraulics fluids directly from tables. 
• A new, flexible, non-discritized line component Lines.Line replaces rigid lines. It is 

also possible to consider elastic wall in Volumes.OilVolume, MultiPortOilVolume and 
Chamber. 

• It is now possible to plot the Reynolds number (variable Re) in Restrictions, to verify 
whether the flow is laminar or turbulent. 

• Derivatives are defined for all oil models (except MSLFluid and JetFuels) and 
restriction functions within Restrictions.Basic.Functions. 

• Added sensor dynamic components in Hydraulics.Sensors.NonIdeal. 

Improvements 
• Directional Control Valves no longer generate a non-linear system of equations. The 

variable P_hyd previously generated a non-linear system, but dynamics is now 
introduced on this variable. 

• The start values of position and velocity in SpoolValve are now set as fixed. 
• Added low pressure warnings in pressure sources and limited pressure at vapor 

pressure. 
• Replaced the MSL component MassWithStopAndFriction with an equivivalent made 

from DualRoadWithStop, ElastoGap, and StribeckFriction. The component was used 
in PressureReliefValve and TwoStage_DCV_Spool. 

• Improved Lines documentation in Lines.Information and friction documentation in 
Cylinders. 

• The oil icon is changed to the orange Hydraulics icon. 
• Hydraulics is now completely independent from the UserInteraction library. 
• Creation of a new subpackage Accumulators. Re-introduced previously depreciated 

accumulator components. 

Conversion of user libraries 

Automatic conversion of user libraries from version 4.1 is supported using the included 
conversion script. 

3.9.9 Hydro Power Library 
A new version 2.4.2 has been released. 

Improvements 
• Improved model documentation. 
• Improved table directory compliance with Modelica. 
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Conversion of user libraries 

No conversion from Hydro Power 2.4 is needed. 

3.9.10 Liquid Cooling Library 
A new version 1.4 has been released. 

New features 
• Introduced the possibility to track trace components that are transported by the liquid. 

Improvements 
• Improved Modelica compliance. 

Conversion of user libraries 

No conversion is needed. 

3.9.11 Model Management Library 
A minor version 1.1.4 has been released. 

3.9.12 Plot3D Library 
A minor version 1.0.4 has been released. 

3.9.13 Pneumatics Library 
A new version 1.7 has been released. 

New features 
• Reduced number of cylinder models to one; DoubleActingCylinder. All old cylinder 

models are replaced with this model. The new cylinder model uses more numerically 
stable end stop and friction models, developed by Modelon as a complement to the 
models in Modelica Standard Library. 

• Added circle on the ports if the component has a volume or defined state. 
• Added new pressure drop components for many different geometries in 

Restrictions.FlowResistances. 
• Fixed a Interface/Template-basic structure throughout the library. 

Improvements 
• Tightened tolerances in many examples for cross compilation platform compatibility. 
• Changed nominal value on mass flow rate in long time to 1e-6 and conductance to 1e-

7 
• Added SpringDamper to booster component for numerical stability reasons. 
• The environment component now uses the Pneumatic top level icon. 
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• Pneumatics library is now completely independent from the UserInteraction library. 

Conversion of user libraries 

Automatic conversion of user libraries from version 1.6.3 is supported using the included 
conversion script. 

The conversion script does not handle some modifiers on the Cylinder component; this has 
to be fixed manually.  

3.9.14 Thermal Power Library 
A new version 1.10 has been released. 

New features 
• Wall model with radial discretization. With this model it is possible to discretize a 

wall in radial direction which can be used for calculation of thermal stress. 
• Generic two phase heat exchanger. 
• Generic gas-gas heat exchanger. 

Improvements 
• Improved Modelica compliance. 
• Combustion with variable Lower Heating Value. The LHV in SolidFuelCombustor 

has been changed from a parameter to an input variable. The SolidFuels media 
interface has also changed from the former LHV constant into a function to define a 
LHV that is dependent of e.g. combustion. 

• The following replacements of models have been made. The new models have 
TubeAndShell fluegas heat exchanger has been replaced by TubeShell. The new 
model has an improved interface which is more user-friendly and has support for more 
correlations. 

o TubeAndShell fluegas heat exchanger has been replaced by TubeShell. 
o Plate two-phase heat exchanger has been replaced by PlateHex. 
o Plate gas – two-phase heat exchanger has been replaced with Plate-

gas2ph. 
• New initialization parameter for SignalDefinedFan. 

Conversion of user libraries 

Automatic conversion from version 1.9 is supported using the included conversion script. 
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3.9.15 Vapor Cycle Library 
A new version 1.2.1 has been released. 

Improvements 
• Improved tutorial. 
• Improved documentation for the heat exchangers. 
• Improved Modelica compliance. 

Conversion of user libraries 

There is no need for conversion of user libraries. 

3.9.16 Vehicle Dynamics Library 
A new version 2.1 has been released. 

New features 

New OpenCRG Ground Model 

The OpenCRG project provides open file formats and open source tools for the detailed 
description and evaluation of 3D road surfaces. OpenCRG data sets are designed to describe 
very detailed patches of road surfaces making them suitable for a broad range of 
applications including e.g. tire and driving simulations. 

The OpenCRG ground model supports both binary and textual OpenCRG data files. 

 

More information about OpenCRG and the OpenCRG project can be found on its website: 
http://opencrg.org. 

OpenCRG is a registered trademark of Daimler AG, Germany. 

http://opencrg.org/�
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Planar Filtering for Wheel/Contact Calculation 

A planar contact calculation filtering method has been added to the Generic contact 
calculation block. The planar filtering method calculates a center frame and contact frame 
based on a plane on the ground surface. The plane is defined by four contact points/frames. 
The contact frames are located on the ground surface in the hub plane, but offset from the 
hub as defined by the offsetGrid parameter. This method is best suited for grounds with 
significant variation in height and road normal, as with the Belgian Block road pictured 
above. 

There are now three choices for the filtering parameter of the Generic contact calculation 
block: None, Geometry weighted, and Planar. This new filtering method is selected by 
choosing "Planar". 

New Tabular Steering Systems 

Two new steering systems are added: GearTabular and RackTabular. These two steering 
systems allow you to define gear/rack displacements relative to steering wheel angle using 
tabular data. Two components, TabularLever and TabularRack, are added to allow creation 
of these models using existing steering templates. 

Improvements 
• A wheel_number parameter is added to all wheel components. The wheel_number is 

often required in external tire force models. This parameter was previously used in the 
contact calculation and sensor components. For consistency, this parameter is added to 
the tire forces, hub and visualization interfaces. The wheel_number is propagated to all 
these components in the base wheel template. 

• Some suspension linkage templates were missing switchable mounts to allow you to 
attach the ride spring and damper to either of the lower control arm, upper control arm, 
or upright. The following templates are now enhanced: 

o DoubleWishboneSTT2 
o DoubleWishboneSTT3 
o DoubleWishboneTT2 
o DoubleWishboneTT3 

3.10 Documentation 
In the software distribution of Dymola 2016 Dymola User Manuals of version “March 2015 
(Dymola 2016)” will be present; these manuals include all relevant features/improvements 
of Dymola 2016 presented in the Release notes.  
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3.11 Appendix – Installation: Hardware and Software 
Requirements 

Below the current hardware and software requirements for Dymola 2016 are listed. 

3.11.1 Hardware requirements/recommendations 

Hardware requirements 
• At least 1 GB RAM 
• At least 400 MB disc space 

Hardware recommendations 

At present, it is recommended to have a system with an Intel Core 2 Duo processor or better, 
with at least 2 MB of L2 cache. Memory speed and cache size are key parameters to achieve 
maximum simulation performance. 

A dual processor will be enough if not using multi-core support; the simulation itself, by 
default, uses only one execution thread so there is no need for a “quad” processor. If using 
multi-core support, you might want to use more processors/cores. 

Memory size may be significant for translating big models and plotting large result files, but 
the simulation itself does not require so much memory. Recommended memory size is 4 GB 
of RAM for 32-bit architecture and 6 GB of RAM for 64-bit architecture. 

3.11.2 Software requirements 

Microsoft Windows 

Dymola versions on Windows and Windows operating systems versions 

Dymola 2016 is supported, as 32- and 64-bit application, on Microsoft Windows 7 and 
Windows 8.1. Since Dymola does not use any features supported only by specific editions 
of Windows (“Home”, “Professional”, “Enterprise” etc.), all such editions are supported if 
the main version is supported. 

Compilers 

Please note that for the Windows platform, a Microsoft C/C++ compiler, or a GCC 
compiler, must be installed separately. The following compilers are supported for Dymola 
2016 on Windows: 

Microsoft C/C++ compilers, free editions: 
• Visual Studio 2008 Express Edition (9.0) 
• Visual C++ 2010 Express (10.0) 
• Visual Studio 2012 Express Edition (11.0) 
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• Visual Studio 2013 Express Edition (12.0) 

Microsoft C/C++ compilers, professional editions: 
• Visual Studio 2005 (8.0) 
• Visual Studio 2008 (9.0) 
• Visual Studio 2010 (10.0) 
• Visual Studio 2012 (11.0) 
• Visual Studio 2013 (12.0) 

GCC compilers 

Dymola 2016 has limited support for the MinGW GCC compiler. The following versions 
have been tested: 
• For 32-bit GCC: version 4.8.1. 
• For 64-bit GCC: version 4.9.2. 

Note the present limitations, and a demand for an add-ons, refer to section “Extended GCC 
compiler support” on page 48. 

Dymola license server 

For a Dymola license server on Windows, all files needed to set up and run a Dymola 
license server on Windows, except the license file, are available in the Dymola distribution. 
(This includes also the license daemon, where Dymola presently supports FLEXnet 
Publisher version 11.11. This version is part of the Dymola distribution.) 

Linux 

Supported Linux versions and compilers 

Dymola 2016 runs on SUSE Linux (Release 11), 32-bit and 64-bit, with gcc version 4.3.4, 
and compatible systems. In addition to gcc, the model C code generated by Dymola can also 
be compiled by clang. To change compiler, change the variable CC in /opt/dymola-
<version>-<architecture>/insert/dsbuild.sh, where <architecture> is 
i586 for 32-bit application, and x86_64 for 64-bit application. As an example, for a 64-
bit Dymola 2016 application: 

/opt/dymola-2016-x86_64/insert/dsbuild.sh 

Dymola 2016 is supported as a 32-bit and 64-bit application on Linux.  

Notes 
• For rendering of jpg files, libjpg62 must be installed. 
• 32-bit compilation might require explicit installation of 32-bit libc. E.g. on Ubuntu: 

sudo apt-get install g++-multilib libc6-dev-386 
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Note on libraries 
• Please note that you have to use the Optimization library version 2.x or higher to use 

multi-criteria design optimization on Linux; the older Design.Optimization package 
does not support multi-criteria design optimization on Linux. 

• The library UserInteraction is not supported on Linux. 

Dymola license server 

For a Dymola license server on Linux, all files needed to set up and run a Dymola license 
server on Linux, except the license file, are available in the Dymola distribution. (This also 
includes the license daemon, where Dymola presently supports FLEXnet Publisher version 
11.11.) 
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